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Selection Filters

https://www.cadlinecommunity.co.uk/hc/en-us/articles/204914222-Autodesk-Inventor-2017-Selection-Priority

Each Inventor environment has a default Selection priority

Part: Faces and Edges

Assemblies: Components

Drawings: Edge

Changing the selection priority will give users faster access to specific geometry

https://www.cadlinecommunity.co.uk/hc/en-us/articles/204914222-Autodesk-Inventor-2017-Selection-Priority


Selection Filters

Access “Selection Filters”:

Shift + RMB



Ctrl to De-select objects

Holding Ctrl when selecting practically 

anything in Inventor, will allow you to de-

select objects that have been selected



Assemblies: Isolate

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201768142-Inventor-1-minute-tip-Isolate

Isolate is often overlooked. In assemblies, 

use it to show and hide components, this is 

especially useful when working on large 

assemblies, or when you need to hide a 

specific part, or if you just want to look at a 

specific set of parts

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201768142-Inventor-1-minute-tip-Isolate


Box Select 

Left to Right

Everything fully inside the box

Right to Left

Everything touching the box



Assemblies: Invert Selection

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202017531  

Use “Invert Selection” to select 

everything other than your current 

selection

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202017531


Object Visibility Filters

Toggle visibility of Workfeatures, 

sketches etc.



Speed: Use the quick access toolbar

Add commonly used tools to the “Quick Access Toolbar”



Templates

Overwriting the Standard.ipt/dwg/iam/ipn

templates with your customised templates 

will make new file creation quicker 



Speed: Smart Templates

• Save pre-selected Material parts (i.e. 

Steel, PP etc.)

• Pre-populate iProperties + Parameters

• Re-use common shapes/start points

• Create sheet Metal templates too 

(Material and Thickness)

Assemblies

• Place virtual components in your 

template file

• Setup your BoM rows in the template file



Use Pack ‘n go to Share files

Pack and Go packages an Autodesk Inventor file and all of 

its referenced files in a single location. All files that 

reference the selected Autodesk Inventor file from a 

selected project or folder can also be included in the 

package.

Use Pack and Go to archive a file structure, copy a 

complete set of files while retaining links to referenced files, 

or isolate a group of files for design experimentation.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201774382-Inventor-Quick-Tip-Pack-and-Go

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201774382-Inventor-Quick-Tip-Pack-and-Go


Speed: Manage Add-ins

Modern versions of Inventor no longer load all of the add-ins at 

start-up.

They are loaded when the first document is opened or created

Unload everything you do not need, including Add-ins you only 

use occasionally, they can always be added back in.

Note that Translators are loaded on demand



Speed: Manage Add-ins

The Add-in Manager can also be loaded as a “Standalone” 

application.

This is useful is a specific add-in is causing stability issues.



Speed:  View – Shadows Reflections & Visual Style

By default visual styles are set in the Inventor File

You can override this in your application options.

Benefits are that models appear as you prefer, and speed

Shadows and reflections slow you down



Speed: F-Key Shortcuts

The Function, or "F" keys on your 

keyboard provide shortcuts for model 

navigation inside of Autodesk 

Inventor, below is a list of these 

shortcuts;

F2 – Pan

F3 – Zoom

F4 – Orbit

F5 – Zoom Previous

F6 – Home View

Bonus UI navigation tools:

The middle mouse button. Holding 

down the middle mouse button 

activates the "Pan" command (as per 

F2). Scrolling the middle mouse 

button will zoom the model in and out. 

Holding Shift and the middle mouse 

button will activate the "Orbit" 

command (as per F4).

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115005983389-Inventor-2018-Quick-Tip-F-Key-Shortcuts

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115005983389-Inventor-2018-Quick-Tip-F-Key-Shortcuts


Speed: Keyboard Shortcuts

Hover your mouse over any 

command in Inventor, you will see 

the shortcut shown in brackets 

after the description. Example -

Fillet (F).

The link below is to a PDF 

containing all Inventor shortcuts

Right Clicking on your Ribbon, 

and selecting “Customise User 

Commands” will allow you to 

modify shortcuts and set up 

shortcuts for commands that are 

not set.

Share your settings using Export 

an import options

https://www.cadlinecommunity.co.uk/hc/en-us/articles/209259909-Autodesk-Inventor-Keyboard-Shortcuts

https://www.cadlinecommunity.co.uk/hc/en-us/articles/209259909-Autodesk-Inventor-Keyboard-Shortcuts


Speed: Customise the Marking (use Gestures)

Right Clicking on your Ribbon, and selecting 

“Customise User Commands” will allow you to 

modify your marking menu settings.

Share your settings using Import and Export 

options

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201902751-Adding-an-Extra-Marking-Menu-in-Inventor-2013

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201902751-Adding-an-Extra-Marking-Menu-in-Inventor-2013


Speed: Disable the Marking Menu (if it's not your thing!)

Right Clicking on your Ribbon, and selecting 

“Customise User Commands” will allow you to 

modify your marking menu settings.

Share your settings using Export an import 

options



Next 3 Tips need your IT department

Image Credit

https://images7.alphacoders.com/354/354101.jpg


Speed:  Anti-Virus Exceptions

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202381031-Managing-your-Anti-virus-software-with-Vault-Inventor-2015
https://knowledge.autodesk.com/support/inventor-products/learn-explore/caas/sfdcarticles/sfdcarticles/Working-with-Inventor-and-antivirus-software.html

Your Company Anti-virus 

software is probably slowing you 

down.

Real time scanning, slows 

access to files

DLL & EXE blocking make parts 

of Inventor inoperable

Note
It is strongly recommended that 
you do not lower the security on 
any computer without good 
reason. Changes to the default 
configuration of your antivirus 
software are made completely at 
the risk of the administrator and 
should only be undertaken if the 
implications of lowering the 
security are completely 
understood

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202381031-Managing-your-Anti-virus-software-with-Vault-Inventor-2015
https://knowledge.autodesk.com/support/inventor-products/learn-explore/caas/sfdcarticles/sfdcarticles/Working-with-Inventor-and-antivirus-software.html


Speed:  Run as Administrator

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115001038129

You may come across instances where Inventor will not load an add-

in or a DLL, this is sometimes manifested in an error message, or a 

function just not working.

When installing Inventor, it should always be done with the UAC 

turned right down, with the user logged on as an Administrator, and 

with the anti-virus disabled. While logged on as Administrator, it is 

advised that Inventor is fired up, as this registers all of the relevant 

DLL's with the Windows operating system.

As a user, If you are still having issues, a nice workaround, is to run 

Inventor as Administrator, this can be achieved by right clicking on 

your Inventor icon and choosing "Run as Administrator"

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115001038129


Speed:  Drivers: Graphics & 3D Mouse

1. Ensure that your system EXCEEDS the minimum specs for 

running Inventor

2. Use the latest Graphics driver FROM AUTODESK, ask your IT 

department to adjust your windows updates 

3. Ensure that your 3D Mouse driver is up to date, if you start 

having unexplained performance issues, unplug and uninstall 

it, see if this remedies the problem.

https://www.3dconnexion.co.uk/index.php?id=76&redirect2=www.3dconnexion.co.uk

Link to Inventor Certified Graphics Cards 

https://www.laptopmag.com/articles/disable-automatic-driver-downloads-on-windows-10
https://www.3dconnexion.co.uk/index.php?id=76&redirect2=www.3dconnexion.co.uk
http://usa.autodesk.com/adsk/servlet/syscert?siteID=123112&id=18844534&results=1&stype=graphic&product_group=12&release=2018&os=524288&manuf=all&opt=2
http://usa.autodesk.com/adsk/servlet/syscert?siteID=123112&id=18844534&results=1&stype=graphic&product_group=12&release=2018&os=524288&manuf=all&opt=2


Back Over to you

Image Credit

https://pixabay.com/en/index-finger-pointing-you-hand-me-315754/


Speed: Graphics

1. If you are experiencing issues, try a lower hardware setting (In 

Application Options)



Speed: Graphics

If you are still experiencing issues, try a lower frame rate, it’s worth 

experimenting with a setting that will suit your system (In 

Application Options)



Speed:  Zoom Direction

Tools > Application Options > Display > Zoom Behavior



Rendering – Ray Trace still images

Save images of your ray trace while it’s 

rendering

Can help with initial views while a large / 

time consuming render completes



Environments

You can turn off an environment, but still 

use it’s lighting and reflections



Do you design Plastic parts? Use the Tooling environment

After some basic setup

Setting material

Selecting Default processing parameters

Estimated Gate location

You can report on Cycle time and Clamping 

pressure, which should help with costings

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202413922-Autodesk-Inventor-2015-Tooling-The-process-of-designing-a-simple-injection-mould

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202413922-Autodesk-Inventor-2015-Tooling-The-process-of-designing-a-simple-injection-mould


Do you design Plastic parts? Use the Tooling environment

Use Part Fill analysis to look for potential 

moulding issues like weld lines

Quality Prediction is useful for sink mark 

areas

Confidence of fill is also very useful

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202413922-Autodesk-Inventor-2015-Tooling-The-process-of-designing-a-simple-injection-mould

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202413922-Autodesk-Inventor-2015-Tooling-The-process-of-designing-a-simple-injection-mould


Do you design Plastic parts? Use the Tooling environment

Inventor can suggest the best Gate 

location for the moulding

This may help inform design decisions

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202413922-Autodesk-Inventor-2015-Tooling-The-process-of-designing-a-simple-injection-mould

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202413922-Autodesk-Inventor-2015-Tooling-The-process-of-designing-a-simple-injection-mould


Application Options

Share your Application Options (remember 

to change your user name!)
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Migrate Application Options + UI (2019)

Migrate your “Application Options” and UI 

customisations from previous version of 

Inventor



Team Web

In Application Options:

Set team web to something useful, like Cadline Community, or your intranet 

Default URL is:
%PUBLICDOCUMENTS%\Autodesk\Inventor %RELEASE%\Web\en-US\CustomHelpSample.htm 



Sketches: Arcs from the Line Command

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201908651-Inventor-Basics-Quick-Tip-Lines-Arcs

After drawing your line, move your mouse pointer to the start point of your 

new line (the end point of your last line). You can then click and drag away 

from that point and create a number of different arcs. Perpendicular or 

Tangent ones in multiple directions depending on the direction of your drag.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201908651-Inventor-Basics-Quick-Tip-Lines-Arcs


Sketches: Inferred Constraints

Hold the CTRL key when drawing in a model sketch to prevent Inventor 

creating inferred constraints. This ignores your constraint settings

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201889052-Inventor-2013-Two-Useful-Sketching-Shortcuts

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201889052-Inventor-2013-Two-Useful-Sketching-Shortcuts


Sketches: Trim and Extend

When in Sketch mode, you can switch 

between the trim and extend command, 

by simply holding down the Shift key on 

your keyboard.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201900751-Inventor-Basics-Quick-Tip-Trim-and-Extend

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201900751-Inventor-Basics-Quick-Tip-Trim-and-Extend


Sketches: Region Properties



Sketches: Dimension Visibility

Toggle visibility of dimensions on a sketch



Sketches: Export Sketch to DXF

Any Sketch in Inventor can be 

exported out to DXF



Sketches: Change Display Colour + Linetype

Adjust the appearance of 

sketches from ”Properties” on the 

right-click menu



Sketches: Equal Spacing

Use a driven dimension as a 

reference to space geometry 

evenly



Parts/Sketches: Parameter naming on the fly

Save time by naming your parameters as you create them

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201814971-Autodesk-Inventor-Parameter-naming-on-the-fly

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201814971-Autodesk-Inventor-Parameter-naming-on-the-fly


All features below the EOP can be deleted by simply 

right clicking on the EOP and selecting “Delete All 

Features Below EOP”

Parts: EOP – Delete Features below the EOP



Parts: EOP – File Size & Emails

Rolling up your end of part makes Inventor files smaller

iLogic rule in the link below automates rolling up EOP and 

attaching to email

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784152-iLogic-Email-your-Part-Files-with-EOP-Rolled-up

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784152-iLogic-Email-your-Part-Files-with-EOP-Rolled-up


Parts: Flat Faces to DXF

Any Flat face in an Inventor part file 

can be exported to DXF with a 

simple right click

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784062-Inventor-2017-Quick-Tip-Export-Face-as-DXF

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784062-Inventor-2017-Quick-Tip-Export-Face-as-DXF


Parts: Mirror Solids

Mirror Solids instead of features generally compute faster, 

also have less errors

Sometimes with bigger file size



Parts: Slice Graphics - Sketches

Use Slice Graphics to see a temporary section 

through your model whist sketching

Keyboard shortcut is F7 

Inventor now has a neat toggle in the sketch 

environment

Bonus Tip: use “Project Cut Edges” to project 

edges into your sketch

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201909131-Inventor-2015-Quick-Tip-Import-Step-Assembly

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201909131-Inventor-2015-Quick-Tip-Import-Step-Assembly


Parts: Split Command – Split faces

Use Split faces for FEA, define specific 

load/boundary conditions, use parametric 

sketches to adjust them

Use Split faces for demarcating different colours 

on a face.



Use “Trim Solid” to cut parts to size

Bonus Tip: Use work planes as the Split Tool

Parts: Split Command – Trim Solid



Use “Split Solid” to split your model in separate 

solids.

Parts: Split Command – Split Solid



Parts: Multi-body solids & Make Components

Convert Multi-Body Solids to Assemblies using 

the Make Components command

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201909131-Inventor-2015-Quick-Tip-Import-Step-Assembly

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201909131-Inventor-2015-Quick-Tip-Import-Step-Assembly


Use the Parameter filter to see all 

“key” and all renamed parameters

2018.1 bought in the “By Feature” 

filter which allows a user to see 

which parameters were used to 

create a feature

Parts: Parameter Filters



Parts: All Fillets + All Rounds 

Useful for cast/plastic components 

that have a specified minimum 

radius.

The feature will continue to 

calculate the fillets, even after the 

geometry changes



Parts: Creating a Hole Pre-set (2019)

• Specify the hole

• Click +

• Give the new pre-set a logical 

name



Parts: Edit Hole Pre-sets (2019)

Pre-sets can be saved, renamed or 

deleted via settings

There is no “Edit” for pre-sets Edit a Pre-set:

• Choose it from the drop down

• Modify the settings to suite

• Save the current setting 

• Choose the old pre-set form the menu

• Delete the old pre-set



Parts: Sharing Hole Pre-sets (2019)

By default Hole Pre-sets are stored locally, this 

location could be set to a network location



Parts: Select Tangencies

“Select Tangencies” selects all 

faces or edges tangent to the 

current selection



Parts: Custom Sheet Metal Flanges

Specify specific flange widths 

and offsets in the expanded 

menu.



Get some Perspective 

Right Click on the view cube > Click Perspective

Use “Perspective” views for renders and images

Tip: it’s faster to work in Orthographic mode



Get some Perspective 

Perspective (Ctrl + Shift + F3)

To adjust the level of perspective 

Ctrl + Shift + F3 and scroll up and down.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201886992-Perspective-in-Inventor-Quick-Tip
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Fast Client image



Assemblies: Assembly Folders

• Use Assembly Folders to organise complex assembly data

• Folders can be used to Isolate or Supress sets of 

components

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201909091-Inventor-Basics-Assembly-Browser-Folders

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201909091-Inventor-Basics-Assembly-Browser-Folders


Assemblies: Virtual Components

Use Virtual Components to add parts to your 

Inventor BoM that you might not normally 

model

Bonus Tip: Use iLogic to add these parts on 

the fly, see link below

Bonus Tip 2: Save commonly used Virtual 

Components in your Assembly file

https://www.cadlinecommunity.co.uk/hc/en-us/articles/212726349-Inventor-2017-iLogic-Create-Virtual-Parts-on-the-Fly

https://www.cadlinecommunity.co.uk/hc/en-us/articles/212726349-Inventor-2017-iLogic-Create-Virtual-Parts-on-the-Fly


Assemblies: Display Mass on a BoM

Use a Virtual Components to calculate the Mass of the 

Assembly, and display this on a BoM

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201884171-Adding-Mass-to-BoM-s-in-Inventor-2012

iProperties.Value("VIRTUAL PART","Custom","Assembly Mass") = iProperties.Mass

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201884171-Adding-Mass-to-BoM-s-in-Inventor-2012


Assemblies: BOM – Check properties & Mass Manipulation 

The BoM environment is a good place to check 

materials and assign properties to many files at 

once.

Copy/Paste between columns

CAPITALISE

Create Expressions

Change Materials

Bonus tip: (Inventor 2018.1 onwards), right click 

on a BoM row entry to open it.

Note: For Vaulted Assemblies, the children (Sub 

assemblies & parts) will need to be checked out if 

their properties are to be edited.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/211622485-Inventor-2017-R2-BOM-tips

https://www.cadlinecommunity.co.uk/hc/en-us/articles/211622485-Inventor-2017-R2-BOM-tips


Assemblies: BOM – Customise Default Template 

Set up your BoM template.

Choose the Rows to include, enable 

the  BoM views that you use by 

default.

Export out an XML file

Open your default template, import 

the XML, “Save as Template”

Done!

https://www.cadlinecommunity.co.uk/hc/en-us/articles/203364071

https://www.cadlinecommunity.co.uk/hc/en-us/articles/203364071


Assemblies: Alt + Drag Constraints

Alt + Drag

If you hold down ALT and then drag (hold 

down your left mouse button) geometry it 

will create a constraint, based on the 

geometry that you select, the animation 

below shows how I have placed an insert 

constraint.

Note: The  Alt + Drag workflow will create 

the following Constraints, Mate, Tangent 

and Insert 

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784012-Inventor-Quick-Tip-Assembly-Constraint-ALT-Drag

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784012-Inventor-Quick-Tip-Assembly-Constraint-ALT-Drag


Assemblies: Save Favourite Bolted Connections

Save and re-use your favourite Bolted 

Connections



Assemblies: Frame Member Info

Use “Frame Member Info” to see 

detailed properties of individual frame 

members, including:

Type

Insertion Position

Mass



Assemblies: Browser Search

Introduced with Inventor 2018.

Search for parts in an assembly (at any level) based on name, part 

number, or iProperty (including custom iProperty values)

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115002126305-Inventor-2018-What-s-new-Browser-Enhancements

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115002126305-Inventor-2018-What-s-new-Browser-Enhancements


Assemblies: Surface Area

The Surface area shown in an assembly is the total Surface area of all parts in the assembly.

For Painting or Coating create shrinkwrap for a more accurate result 

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201768952

Assembly = 2882.411mm^2                                                                      Shrinkwrap = 2505.420mm^2 

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201768952


Assemblies: Shrink Substitute LoD’s via iLogic

Reduce model 

complexity with LoD’s

Use Shripkwrap

substitute LoD iLogic 

Rule to quickly create 

simplified LoD’s

https://www.cadlinecommunity.co.uk/hc/en-us/articles/214383385-Inventor-2017-iLogic-
Create-Shrink-wrap-Substitute-Level-of-Details?page=3

https://www.cadlinecommunity.co.uk/hc/en-us/articles/214383385-Inventor-2017-iLogic-Create-Shrink-wrap-Substitute-Level-of-Details?page=3


Collaborate with Shared views (new in 2019)

Shared Views last 30 days (unless 

renewed)

Allows collaboration over the web

Great for collaborators who do not have 

CAD tools!

Works with parts, assemblies and 

drawings



Lost in Translation: ANYCAD v STEP v IGES

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115000846485-STEP-Files-vs-IGES-Files

Always try get hold of the native CAD files, Inventor works with practically every mainstream CAD vendor, AnyCAD workflow is 

better than a file translation

The IGES standard was last updated in 1996

STEP has been available for over 20 years with continual development and wide adoption between CAD vendors

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115000846485-STEP-Files-vs-IGES-Files


Backward Compatibility

Starting with Inventor 

2017.4, you can reference

future (newer) versions of 

Inventor part and assembly 

files.

For example, you can now 

reference an Inventor 2018 

part file in Inventor 2017

Inventor 2017.4 Inventor 2018
https://www.cadlinecommunity.co.uk/hc/en-us/articles/115002610585-Inventor-2017-4-Subscription-update-adds-backward-compatibility-for-Inventor-2018

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115002610585-Inventor-2017-4-Subscription-update-adds-backward-compatibility-for-Inventor-2018


Get some Perspective - Drawings

Since Inventor 2016, we can now use the "View Cube" 

to orientate our views, and as such, we can place 

Perspective views as opposed to Isometric views on 

our drawings, giving more realistic appearance to a 

"pictorial" view.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/203899721-Inventor-2016-Quick-Tip-Perspective-on-Drawings

https://www.cadlinecommunity.co.uk/hc/en-us/articles/203899721-Inventor-2016-Quick-Tip-Perspective-on-Drawings


Drawings: use AutoCAD for dimensions

Did you know that you can 

dimension your Inventor DWG 

files in AutoCAD?

AutoCAD uses the same 

dimension style as your 

Inventor drawing



Drawings: Annotating Punch tools

On “Flat” sheet metal parts, you need to create a Flat Pattern, in order to use the annotation tools for punches

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201768212-Inventor-Annotating-Punch-Tools

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201768212-Inventor-Annotating-Punch-Tools


Drawings: Replace Reference

Introduced in Inventor 2011

Allows you to re-use your existing 

drawings 

Works when the geometry is the same 

i.e. “File” > “Save As”



Drawings: Sketchy lines

Revit & AutoCAD 2015 introduced 

“Sketchy Lines”

Open your Inventor DWG in 

AutoCAD, change the view to 

“Sketchy Lines”

Export to PDF or Image – “Sketchy 

Lines” will not show in Inventor

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201901301-Inventor-Quick-Tip-Sketchy-lines

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201901301-Inventor-Quick-Tip-Sketchy-lines


Drawings: Change your sheet colour

Tools > Document Settings

Note that this setting is file specific 



Drawings: Precision & Copy Properties

http://www.inventortales.com/2007/10/copying-properties-copy-if-you-can.html

Set Precision from a right click

Similar to “MATCHPROP” in AutoCAD

“Copy Properties” of one dimension to others

http://www.inventortales.com/2007/10/copying-properties-copy-if-you-can.html


Simulation: Symmetry 

Inventor does not have a 

Symmetry Command in the 

Simulation Environment

Instead use a Frictionless 

Constraint

Remember to check your 

loads! In this example, the load 

is divided by 4, as the model is 

split into 4

See the full video here:

https://knowledge.autodesk.com/support/inventor-products/getting-started/caas/CloudHelp/cloudhelp/2016/ENU/Inventor-EssentialVideo/files/GUID-F09B5F27-E11A-4154-8185-6895C2511987-htm.html

Frictionless Constraints on 
the faces highlighted in blue

https://knowledge.autodesk.com/support/inventor-products/getting-started/caas/CloudHelp/cloudhelp/2016/ENU/Inventor-EssentialVideo/files/GUID-F09B5F27-E11A-4154-8185-6895C2511987-htm.html


Simulation: Component Visibility

Toggling visibility of 

Components:

Does not remove them from 

analysis

Hides them in the results, 

making it easier to interpret your 

results



Simulation: Share your results via DWF 

Export out a DWF with your 

results showing

Note: this is not a supported 

workflow, and does not work 

with very large or complex 

models



Parts: Direct Edits

Use Direct Edits to modify “Dumb 

Geometry”, or event o make tweaks 

to existing designs

Remember all changes are 

parametric

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784032-Direct-Edits-in-Autodesk-Inventor-2015

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784032-Direct-Edits-in-Autodesk-Inventor-2015


Customise the Navigation Bar

Add the navigation tools that you use most 

commonly to the Navigation toolbar



Drawings: Set Transparency

Inventor 2016 introduced 

“Component 

Transparency” in the 

drawing environment.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/203037872-Inventor-Drawing-Transparency-tips

https://www.cadlinecommunity.co.uk/hc/en-us/articles/203037872-Inventor-Drawing-Transparency-tips


Assemblies: Degrees of Freedom Analysis

This tool is located under the Productivity Panel of 

the Assemble Tab. 

When you click on ”Degree of Freedom 

Analysis” a table will appear, showing all of the 

parts in the assembly. 

If you tick the Animate Freedom box, animations of 

the available movement of the part will be shown on 

screen

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784022-Inventor-Quick-Tip-Assembly-Constraint-Analysis

https://www.cadlinecommunity.co.uk/hc/en-us/articles/201784022-Inventor-Quick-Tip-Assembly-Constraint-Analysis


Code Free iLogic

Forms:

Perhaps one of the most 

overlooked areas of iLogic is 

the forms interface. Forms 

allow you to easily interact 

with iProperties and 

Parameters in your models 

and drawings. If you still use 

prompted entries to enter 

critical design information, 

you may want to consider 

changing to a more modern 

looking form based interface.

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115005505885

https://www.cadlinecommunity.co.uk/hc/en-us/articles/115005505885


iLogic: Some Best Practice
Keep things simple:

Don’t try to do everything in one rule.

Comment your code:

• ‘Adding comments to you code, will help your colleagues, or 

your memory when reviewing code later

Use External Rules where possible:

• Far easier to update if things change. Embedded rules are 

difficult to “Fix”

2 disadvantages – 1: The rules don’t run on parameter changes
2: The rules are not embedded in the files if sharing 

externally

Use forms to link external rules

• Add rules to your forms, these can be pushed like buttons

Event Triggers:

• Running rules “After Save” - ensure that these do not change 

the file (Ok for file exports (STEP etc.) not good for changing 

iProperties or parameters, as the file will need to be updated



Drawings: Fixing Overridden Dimensions

Choose “Select All Overridden 

Dimensions” tool from the selection set 

dropdown 

Right Click and choose “Edit” this will 

bring up the Edit dimension dialogue.

Delete the overridden value and then un-

tick the “Hide Dimension Value” box. 

To cycle through all of the dimensions, 

Right Click and select “Repeat Select All 

Overridden Dimensions” then Right 

Click and choose “Edit”

Repeat the process until all of the 

offending dimensions have been 

corrected. 

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202284791-Autodesk-Inventor-Fixing-overridden-dimensions

https://www.cadlinecommunity.co.uk/hc/en-us/articles/202284791-Autodesk-Inventor-Fixing-overridden-dimensions


Drawings: View Scales 

Set the scale of the views on the 

drawing by simply dragging the 

corner of the Base view. 

(introduced in 2016)

https://www.cadlinecommunity.co.uk/hc/en-us/articles/204249431-Inventor-2016-17-Quick-Tip-Drawing-View-Scale

https://www.cadlinecommunity.co.uk/hc/en-us/articles/204249431-Inventor-2016-17-Quick-Tip-Drawing-View-Scale


Open from Vault Tips 

• Use the “Browse Vault” Button on the “file> Open” 

dialogue

• Add “Open from Vault” to the quick Access 

toolbar

• Add “User Commands” to “Log In” and to “Open” 

from Vault



Questions ?

@ClintBrown3D

Image Credit

https://pixabay.com/en/abstract-abstraction-acceleration-164329/
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